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Sew Authentic Jeans – Machine Accessories Make It Easy
4	 What makes a pair of pants into “jeans”? Rugged construction, typified by 

bulky seams and hems and double-stitched accents, is the key. With the 
right tools, and our tips & tricks, you can replicate these features on your 
home sewing machine. 

Petals & Posies Glasses Case
8	 Who says girls with glasses have to keep them in boring cases? This beautiful 

cutwork case is stitched almost entirely on the embroidery machine. If you 
have the BERNINA CutWork Accessory, your machine will even do the fussy 
cutting for you!

Sweet Dreams
10	 Use your serger and a pre-cut quilt-block kit to create a great baby shower 

gift in an afternoon! In this cuddly quilt, basic serger stitches are paired 
with decorative threads to produce seams that are attractive as well as 
functional. 

Floralicious Placemats & Napkins
12	 This pair of reversible placemats, featuring the coordinating Benartex fabric 

and OESD embroidery “Floralicious” collections, is a bright and cheery 
accent for spring.

Floral Visions Heirloom Pillow
16	 The BERNINA 830 has the tremendous capability of bringing ALL sewing and 

decorative stitches into its embroidery system, and embroidering them 
instead of stitching them. Several of these “transformed” stitches were 
saved and transferred to BERNINA Embroidery Software, and then used 
to create perfectly proportioned stitches for the oval “frames” on this 
heirloom-inspired pillow.

The Last Word
20	 Valuable coupons, a list of quick links, and a sneak peek inside the next 

issue of Through the Needle ONLINE.
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It’s spring! It may not feel like it in northern parts of the USA, but spring officially arrived in March regardless of 
the amount of snow still falling. Need some convincing? Stitch up a set of our Floralicious Placemats and Napkins 
and you’ll be ready for al fresco dining on the patio, even if you have to clear away the snow before you set the 
table.

Spring is also the perfect time to sew new items for your wardrobe — a great pair of jeans, for example. 
Shopping for jeans can be a two-fold challenge. Finding a pair that fits comes first, but often when you finally 
find a pair that does fit, the style is hopelessly wrong. If you make your own jeans ... well, that’s a different 
story. It’s easy to make authentic “jeans” when you use just the right collection of feet and accessories for 
sewing denim. Pair these with select sewing techniques and you’ll be wearing jeans that fit and look great in  
no time! 

Sunglasses, reading glasses, and regular old “need-em-to-see” spectacles — they all deserve a protective case 
that’s pretty as well as functional. And with Mother’s Day just around the corner, wouldn’t a custom-made 
case be a great gift for Mom? The beautiful cutwork on this elegant accessory is from OESD’s Posies & Petals 
embroidery collection. All of the stitching and cutting can be done on your embroidery machine using the 
BERNINA CutWork Accessory. While your embroidery machine is stitching away, pull out your serger and make a 
snuggly Minkee patchwork quilt. Pre-cut blocks from Benartex and speedy serger seaming make construction  
oh-so-fast. You’ll only need your sewing machine for sewing on the buttons! 

I hope you enjoy this issue of Through the Needle ONLINE. I love hearing from our 
readers, so if you have suggestions for future issues, please send them to me at  
jo @ berninausa.com.	Have a lovely spring, and watch for our next issue in June! Jo Leichte 

Editor

Ruffled Scarf
Design a ruffled scarf without ruffling 
a single feather. Create this unique, 
playful scarf so quickly and easily that 
you’ll want one for every outfit and 
season. With spring just around the 
corner, begin your collection with a 
light, breezy cotton scarf!

Project by Ashley Johnston

Visit sewingrepublic.com for more 
project instructions and sewing tips!

http://www.throughtheneedle.com
http://www.berninausablog.com/jo-leichte
http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://sewingrepublic.com/
http://sewingrepublic.com/
http://sewingrepublic.com/projectIdeas.html#/RuffledScarf/
http://sewingrepublic.com/projectIdeas.html#/RuffledScarf/
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by JO LEICHTE

“5-Pocket Jeans” for 
BERNINA My Label 3D 
Fashion Pattern Software

Nearly everyone has a denim garment in their wardrobe: a pair 
of jeans that fit just right, a pencil skirt with jeans detailing, 
or a well-worn jacket that goes with everything. From the first 
pair of hard-wearing denim pants stitched by Levi Strauss during 
the Gold Rush to the designer jeans of today, “blue jeans” are 
an American icon and a ubiquitous part of modern culture. What 
makes a pair of pants into “jeans”? The rugged construction — 
typified by bulky seams and hems and double-stitched accents 
— is the key. Ready-made jeans are sewn on industrial machines 
that are specially designed to produce these features, but with 
the right tools, and these tips & tricks, you can replicate them 
on your home sewing machine. 

Kwik-Sew #3504

Kwik-Sew #3431

Kwik-Sew #3193

Sew  
Authentic 

Jeans
Machine Accessories Make it Easy

http://www.berninamylabel.com/
http://www.berninausablog.com/jo-leichte
http://www.berninausa.com/product_overview-n2-sUS.html
http://kwiksew.com/catalog/cat_detail.cfm?pid=3431
http://kwiksew.com/catalog/cat_detail.cfm?pid=3504
http://kwiksew.com/catalog/cat_detail.cfm?pid=3193


sewing into the bulky 
area, nudging the tool 
forward as you go. 
As the foot begins to 
move off the seam, 
move the tool to 
the side of the foot, 
keeping the sole level. 
Remove the tool when 
no longer needed.

Jeans Foot
Designed specifically for 
straight stitching over 
bulky seams, a jeans foot 
(BERNINA Jeans Foot #8/8D) 
supports the fabric around 
the needle and prevents it 
from pulling the fabric when 
it moves up and down. It is 
also engineered to prevent 
Jeans needles from flexing 
and breaking.

Edgestitch Foot
Contrast stitching gives the jeans style its distinctive 
appearance. Keeping those stitches perfectly parallel 
to the edges can be difficult, particularly when 
working with bulky fabrics like denim. An edgestitch 
foot, such as BERNINA Edgestitch Foot #10/10C/10D, 
will be your new BFF! (BERNINA Friend Forever!). 
Simply move the needle position a few clicks to the 
left and move the fabric edge along the guide in the 
center of the foot. Stitches will be placed just inside 
the edge.

TIP: For perfect pocket 
points, stitch to a corner 
and stop with the needle 
down in the fabric. Raise 
the presser foot, pivot the 
fabric around the needle, 
lower the presser foot, 
and continue stitching. For 
faster and more efficient 
stitching, raise and lower 
the presser foot using the 
knee lever of the BERNINA Free Hand System — this 
lets you keep your hands on your project rather than 
on the lever.
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Machine Accessories:  
Tools for Perfect Seams and Hems
Height-Compensating Tool
Skipped stitches and snapped needles? With the 
Height-Compensating Tool you’ll sew quickly and 
easily over every seam. Simply sew as you normally 
do, stopping when the presser foot comes up against 
the cross seam. Adjust the number of strips to 
one, two, or three, depending on the thickness of 
the seam to be sewn over. With the needle down 
in the fabric, raise the presser foot and place the 
tool under the foot and behind the needle. This 
levels the sole, allowing it to continue pressing 
against the feed dog and feeding the fabric through 
the machine. Lower the presser foot and continue 

The Basics: Stitches, Needles, and Thread
•	For construction, select a medium-long, straight 

stitch with a stitch length of 3mm and use a 
strong thread such as Mettler Metrosene Plus. 
Despite its fineness, this thread has a very high 
tensile strength and abrasion resistance, making 
it the ideal thread for sewing jeans.

•	For plain seaming on denim using construction-
weight thread, select a size 80/12 or 90/14 
Jeans needle. Jeans needles have very sharp 
points and are able to penetrate thick, sturdy 
material easily.

•	Use a thick thread for contrast topstitching, 
such as Mettler Cordonnet or YLI JeansStitch, 
and lengthen the straight stitch length to 4mm. 
Get the look of ready-made jeans by using 
gold-colored threads such as Mettler Cordonnet 
colors #0261 and #0172 or YLI JeansStitch colors 
#8 (Topaz Gold) and #7 (Blue Jean Gold).

•	For contrast stitching with topstitching thread, 
select a size 90/14 or 100/16 Topstitch needle. 
The large eye and deep groove accommodate 
the thick thread and allow it to move easily 
through the fabric.

•	Use an overlock or 
overcast stitch with 
construction-weight 
thread for finishing raw 
edges, such as the fly 
facing. Alternatively, 
use a serger 4-thread 
overlock stitch 
with regular weight 
polyester serger 
thread such as Mettler 
Metrocor or YLI Elite 
Premium Serger 
Thread.

http://www.wireworld.com/amefird/mettler.html
http://www.wireworld.com/amefird/mettler.html
http://ylicorp.com/
http://www.berninaneedle.ch/_upload/newsletter_4.pdf
http://www.berninaneedle.ch/_upload/INSWE0294.pdf
http://www.berninausa.com/product_overview-n5-sUS.html
http://ylicorp.com/
http://ylicorp.com/
http://www.wireworld.com/amefird/mettler.html
http://www.wireworld.com/amefird/mettler.html
http://www.berninausa.com/product_detail-n25-i51-sUS.html
http://www.berninausa.com/product_detail-n25-i51-sUS.html
http://www.berninausa.com/product_detail-n25-i140-sUS.html
http://www.berninausa.com/product_detail-n25-i140-sUS.html
http://www.berninausa.com/product_detail-fF_102-n2-i328-sUS.html


Belt Loops
Instead of being drafted 
with seam allowances, 
belt loops are generally 
cut in a long strip just 
under three times the 
finished width. Finish 
one long edge with an 
overcasting stitch or 
serger overlock. Fold 
the strip in thirds, first 
turning the raw edge 
under, then covering it 
with the finished edge. 

Topstitch both long edges from the right side, 
then cut into shorter lengths as directed by the 
pattern instructions. 

TIP: As an alternative to edgestitching, sew 
along the center of the strip using a 4mm wide 
Double needle. Another option is a serger 
coverstitch. With these methods the underside 
of the beltloop is encased in stitches, so it is not 
necessary to finish one long edge before folding. 

Bartacks are the authentic way to attach belt 
loops and reinforce the stress points of pockets 
and fly zippers. Use Wonder Tape to hold the belt 
loops in place, then use the Height Compensating 
Tool to level the sole of the presser foot when 
stitching them in place.
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Seam Guide
A double row of stitches along the side seams is 
another feature of jeans-style garments. After 
sewing the first row of 
stitches with an edgestitch 
foot, as above, attach 
an all-purpose foot and a 
seam guide to the machine. 
Shown here are BERNINA 
Reverse Pattern Foot #1D 
and the Adjustable Seam 
Guide. Adjust them as 
needed, then stitch, guiding 
the fabric easily along the 
edge.

TIP: If your sewing machine has a dual-feed feature, 
such as the one on the BERNINA 8 Series machines, 
engage it when topstitching your denim seams.

Automatic  
Buttonhole Foot

Sew a test buttonhole 
through layers of scrap 
denim before stitching 
it on the project. For 
an accurate test, use 
the same layers of 
denim and interfacing 
as are in the waistband. 
Once the buttonhole 
is programmed into 
memory you are able to 
stitch as many identical buttonholes as needed for 
your project. 

Tip: The slit width of buttonholes on the BERNINA 8 
Series sewing machines can be adjusted as needed to 
accommodate thick-shank buttons. 

Clear Foot
An all-purpose presser foot 
with a clear sole (BERNINA 
Clear Foot #34/34C) 
provides increased visibility 
in the stitching area. This 
is especially helpful when 
sewing curves and corners.

 

 
Zipper Foot
Jeans typically have a fly zipper, which is basically 
a zipper with a flap behind it. A zipper foot allows 
stitching right at the edges of the foot, which makes 
it possible to stitch against the bulky areas, including 
zipper coils and the fly shield that lies underneath 
the zipper.

http://www.bernina8series.com/EN/
http://www.bernina8series.com/EN/
http://www.berninausa.com/product_detail-n26-i85-sUS.html
http://www.berninausa.com/product_detail-n25-i272-sUS.html
http://www.berninausa.com/product_detail-n25-i257-sUS.html
http://www.berninausa.com/product_detail-n25-i136-sUS.html
http://www.berninausa.com/product_detail-n25-i137-sUS.html


Flat-Felled Seams
For authentic jeans style, sew the outer leg edges 
together with a flat-felled seam. 

Traditional Flat-Felled Seam
Because it is stitched twice, this 
seam is very sturdy. Bulkier than a 
traditional seam, flat-felled seams 
are completely finished on both 
sides, having the raw edges tucked 
inside and stitched in place. 

•	Pin the fabrics wrong sides 
together. Stitch, then press the 
seam allowances to one side. 

•	Trim the lower seam allowance to 
half its width.

•	Fold the top seam allowance around the lower 
one; press.

•	Edgestitch the fold to hold it in place. In addition, 
edgestitch along the seam, creating parallel rows 
of stitching about ¼" apart.
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•	Position the fabric under the foot again; this time 
stitch along the fold line to create a second line of 
stitching along the folded edge.

TIP: Sew a few stitches at the beginning of the seam to 
tack the fold in place before loading it into the foot. 

TIP: When stitching over bulky seams, remove the 
fabric from the foot just before the seam, stitch 
over the bulk, then reinsert the fabric and continue 
stitching. 

Faux Flat-Felled Seam
This seam is simpler to sew than a true flat-felled 
seam. From the outside it looks like a flat-felled 
seam, but the seam allowances 
are visible on the inside of the 
garment.

•	Pin fabrics right sides together 
and stitch as for a plain ⅝"-
wide seam. 

•	Overcast (or serger overlock) 
the seam allowances together 
and press them toward the 
back of the garment. 

•	From the right side, 
edgestitch close to the seam 
line. Topstitch about ¼" from 
the edgestitching; this stitching will hold the seam 
allowances in place. 

Resources
Inspiration magazine, Issue #43, Spring 2009  
http: // www. bernina .com/naviinfo-n31-sEN.html 

“My Label Jeans” webinar, Debbi Lashbrook, May 
2009 (www. berninausa .com > Online Classes > My 
Label Classes) http: // www. berninausa. com/news_
detail-n546-r0-i3545-sUS.html 

Feetures Volumes 1 & 2, Jo Leichte and Susan Beck, 
editors, ©BERNINA of America, Inc., 2002

Felling Foot Seam
A felling foot (BERNINA 8mm Lap Seam Foot #71) 
eliminates the tedious trimming and folding needed 
to produce traditional flat-felled seams, and is 
appropriate for light- to medium-weight denim.

•	Allow a total of ¾" for seam allowances: ½" for 
the folded piece + ¼" for the covered piece. Or 
— to make the math easy — just trim ¼" off each 
seam allowance; this will only slightly change the 
location of the seam.

•	Place fabric edges wrong sides together, with the 
longer piece underneath — ½" extends to the right 
and is folded over the inner edge. 

•	Align the fold with inner edge of the right toe of 
the foot and adjust the needle position to the left 
as shown. Stitch; the fabric edge is automatically 
folded and held in place for stitching.

http://www.berninausa.com/content-n910-sUS.html
http://www.berninausa.com/product_detail-n25-i52-sUS.html
http://www.berninausa.com/news_detail-n546-r0-i3545-sUS.html
http://www.bernina.com/naviinfo-n31-sEN.html
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Left click on the Grid icon to turn on the grid.

Create a fabric placement line: Select the Open 
Object tool and a straight stitch. Starting five grids 
spaces down and four grids spaces from the center, 
digitize the line using left and right clicks around the 
hoop. Press Enter.

Create the tack-down stitches: Copy and Paste the 
line and change the color. 

Press Ctrl + A on 
the keyboard to 
Select All. Click on 
the Align Centers 
icon. 

Click on the Grid 
icon to remove 
the grid. 

Petals  
& Posies 
Glasses 
Case

Supplies
•	Embroidery machine
•	Sewing machine
•	BERNINA CutWork compatible sewing machine 

(optional)
•	BERNINA CutWork Software and Accessory 

(optional)
•	BERNINA Embroidery Software 6
•	7" x 11" rectangle of UltraSuede®

•	7" x 11" rectangle of batik fabric for lining
•	OESD BadgeMaster Stabilizer 
•	Steam-A-Seam 2 double-stick fusible web
•	505 Temporary Basting Spray 
•	Isacord embroidery thread to blend with 

UltraSuede®

•	Large oval hoop 
•	Sharp embroidery scissors
•	Echo-Quilting and CutWork Foot #44
•	Edgestitch Foot #10/10C/10D

In the Embroidery Software
Select File > New. 

Right click on the Hoop icon and select artista 
255x145 Oval w/X-Y lines from the list of available 
hoops. Click OK. 

Who says girls with glasses have to keep 
them in boring cases? This beautiful 
cutwork case is stitched almost entirely on 
the embroidery machine. If you have the 
BERNINA CutWork Accessory, your machine 
will even do the fussy cutting for you! (Or 
you can use sharp scissors to do the cutting 
yourself.) Instructions for both methods 
are included with OESD’s Petals & Posies 
Crafters Collection #011.

by ELAINE CIBELLI

Visit www.berninausa.com 
to download instructions for 
a coordinating Pocket Full of 
Petals & Posies Purse.

http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://www.berninausa.com/product_detail-n6-i294-sUS.html
http://www.berninausa.com/webautor-data/798/PetalsPosies-OESD011.pdf
http://www.berninausa.com/default-sUS.html
http://www.berninausa.com/product_overview-n3-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.benartex.com/page/index.php?page=gallery-detail&pg_o=&collection=247
http://www.warmcompany.com/lsaspage.html
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBABM-12
http://www.berninausa.com/product_overview-n3-sUS.html
http://www.berninausa.com/product_overview-n2-sUS.html
http://www.berninausa.com/product_search-n29-r17-sUS.html
http://www.berninausa.com/product_detail-n25-i140-sUS.html
http://www.berninausa.com/product_search-n25-sUS.html


Select File > Insert Design and navigate to the Petals 
and Posies design folder. Select BC01107_CWC for 
use with the BERNINA Cutwork Tool; otherwise 
select BC01107. Center the design inside the oval 
placement line and to the right of the hoop center 
line. 

With the design selected, click on the Mirror-Merge 
Horizontal icon to create a duplicate; use the center 
line of the hoop to help with positioning. Press Enter.

To create the stitching line, select, copy, and paste 
the placement line, then change the color of the 
stitches. Change Outline to Triple stitch. 

Use Color Film to re-sequence the stitch objects: 
Hold down the Ctrl key and select the stitching line, 
then select the placement line and click on the Align 
Centers icon. Select Sequence to End. 

Reduce the number of thread changes by selecting 
Arrange > Stitch Sequence and clicking on Yes. 

Save the design as CutWork Glasses Case.

Select the Write to Machine icon to send the design 
to the machine or a BERNINA Memory Stick. 

At the Embroidery Machine 
Hoop a piece of BadgeMaster stabilizer in the Large 
Oval Hoop. 

Stitch the first color—the fabric placement line—on 
the stabilizer. 

Spray the wrong side of the UltraSuede® with 505 
Temporary Adhesive and smooth it into place over 
the stitched outline. Be sure to cover the outline 
completely.

Stitch the next color of the design, the staystitching. 

Change to the BERNINA CutWork tool and follow the 
on-screen prompts to cut the fabric away from inside 
the lines. Alternatively, remove the hoop from the 
embroidery machine and use scissors for the cutwork 
following the instructions included with the design 
collection. 
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After cutting, 
patch the stabilizer 
by spraying the 
underside of the 
hooped stabilizer 
with 505 Temporary 
Adhesive and 
covering the holes 
with a piece of BadgeMaster. 

Continue stitching the embroidery design.

Place the lining fabric right side down on top of the 
hooped cutwork and embroider the triple stitching. 

Remove the project 
from the hoop 
and trim the seam 
allowances a scant ¼″ 
from the stitching line. 
Turn the case right 
side out through the 
opening. 

Working from the 
lining side, carefully 

press the outer edge. Tuck a small piece of Steam-A-
Seam 2 between the seam allowances; fuse to close 
the opening.

Fold the case in half with the lining inside and 
the finished edges aligned. Attach Edgestitch Foot 
#10/10C/10D to the machine and move the needle 
position to the left. Align the edge of the glasses 
case with the guide in the center of the foot, then 
stitch the 
sides together 
along the 
long, curved 
edge only, 
leaving the 
top of the 
case open.
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by BRANDON GARBERSergers can be used for so much more 
than just joining and overlocking 
seams. In this cuddly quilt, two basic 
serger seam operations are paired with 
decorative threads to produce seams 
that are attractive as well as functional. 
When using pre-cut squares from a 
Benartex quilt kit, this cozy and adorable 
blanket goes together very quickly! This 
project is a great canvas for machine 
embroidery—consider adding a large 
motif on one corner or scatter several 
randomly throughout the squares.

Sweet Dreams
Supplies 
•	Sewing machine  

(BERNINA artista 630)
•	Serger (BERNINA 1300MDC)
•	1 “Minkee Tween” or “Minkee Safari”  

quilt kit by Benartex
•	2 yards of 44"-wide quilter’s cotton  

for backing (pre-washed)
•	12 coordinating buttons, ¾" or ⅞" diameter
•	3 spools of Pearl Crown Rayon by YLI
•	1 spool of King Tut by Superior Threads
•	1 spool of coordinating serger thread
•	Size 90/14 Topstitch needle
•	Button sew-on foot (BERNINA Button Sew-On Foot #18)

http://www.berninausa.com/product_overview-n2-sUS.html
http://www.berninausa.com/product_detail-n2-i13-sUS.html
http://www.berninausa.com/product_overview-n5-sUS.html
http://www.berninausa.com/product_detail-n5-i5-sUS.html
http://www.benartex.com/index.php?page=gallery-detail&collection=197&pg_o=&fabricView=&numberOfFabrics=12&pg_c=2&
http://www.benartex.com/index.php?page=gallery-detail&collection=197&pg_o=&fabricView=&numberOfFabrics=12&pg_c=3&
http://www.benartex.com
http://www.ylicorp.com
http://www.superiorthreads.com/shop/category/king-tut/colorcards/
http://www.berninaneedle.ch/_upload/INSWE0294.pdf
http://www.berninausa.com/product_detail-n25-i250-sUS.html


Serge the Rows
Thread the serger for a wide 3-thread flatlock with 
Pearl Crown Rayon in the upper looper, King Tut in 
the lower looper, and regular serger thread in the 
left needle. Make the following adjustments:

•	Upper Looper Tension = 3
•	Lower Looper Tension = 8
•	Left Needle Tension = 2
•	Right Needle = Removed
•	Stitch Length = 3
•	Differential Feed = N

Join two squares by placing 
them wrong sides together 
and serging along one side, 
trimming only about ⅛" of fabric from the edge. 
Minkee is a knit fabric, so join the blocks forming 
the rows on the lengthwise grainline. The flatlocked 
seam will look like a regular overlock stitch as it 
comes off the machine. 

Grip each block close to the 
seam and pull the squares 
apart. The seam will open and 
lie flat, exposing the Pearl 
Crown Rayon on the quilt top 
and a ladder-like stitch on the 
wrong side. 

Working left to right and top to bottom, assemble 
rows of blocks using the diagram from the quilt kit as 
a guide. 

Join the Rows
Serge the rows together 
in the same manner. It is 
helpful to pin periodically at 
this point, especially at seam 
intersections, to line up the 
rows correctly. Serge, always 
pulling out the pins before 
they reach the cutting knife.

After serging, grip and pull these final four seams to 
flatten them.

If desired, embroider one or more of the squares at 
this point. The design shown in the photo on page 10 
is the OESD “Paisleys 2” Embroidery Collect #12220, 
design #NB251_48.

Finish the Edges
Place the flatlocked patchwork 
piece on top of the backing 
fabric, wrong sides together. 
Placing pins parallel to the 
blanket edges, pin the quilt to 
the backing at each seam. Also 
pin each block to the backing 
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in the center, halfway between each set of seams. 
Pin each of the twelve seam intersections as shown.

Thread the serger for a 4-thread overlock stitch.  
Use new spools of Pearl Crown Rayon in the loopers 
so you won’t run out of thread in the middle of a 
long edge. Thread the left needle with King Tut.

•	Upper Looper Tension = 4
•	Lower Looper Tension = 4
•	Left Needle Tension = 4
•	Right Needle Tension = 4
•	Stitch Length = 3
•	Differential Feed = N

Serge all four edges of the 
quilt, cutting off a scant ⅛" 
of the Minkee and always 
pulling out the pins before they reach the cutting 
knife.

Finish the corners by knotting the thread tails and 
clipping or applying seam sealant. 

Attach the Buttons
Note: If making the Sweet Dreams Quilt for infants 
or young children, omit the buttons and stitch the 
layers together without them. 

Insert a size 90/14 
Topstitch needle in the 
machine and attach the 
button sew-on foot. 
Thread the sewing machine 
with King Tut in the needle 
and bobbin. 

Select a Button Sew-On 
stitch (or a Universal stitch 
with stitch length turned 
to 0). Place a button over a seam intersection and 
stitch it in place. Repeat for the remaining buttons.

Brandon Garber is from Iota, Louisiana, and holds a 
BS degree in Apparel Design & Merchandising. After 
college he worked for Dillard’s department stores 
as a Technical Designer for 
children’s sportswear. He 
says he’s sewn on every 
machine imaginable, but 
has always returned to 
his BERNINA! He moved to 
Dallas, Texas, in 2009 and 
ever since then has been 
working for BERNINA (“The 
best company ever!”). He 
is Store Manager for BERNINA Sewing Center 400 in 
Garland, Texas. In his spare time he enjoys sewing 
and playing electric guitar.



Floralicious 
Placemats & 

Napkins

1 2  •  T H R O U G H  T H E  N E E D L E  O N L I N E

by ELAINE CIBELLI

This pair of reversible placemats, made with fabrics from the 
Benartex “Floralicious” collection, are a bright and cheery 
accent for spring. Appliquéd flowers from the coordinating 
OESD “Floralicious” embroidery collection embellish the side 
panel and napkin sleeve. Serged napkins complete the set.

Supplies
•	OESD “Floralicious” by Michele D’Amore 

Embroidery Collection #1103
•	BERNINA Embroidery Software (optional)
•	Benartex “Floralicious” fabrics

—	½ yard Small All Over—Black Multi
—	¼ yard Leaf Vine—Green Multi 
—	¼ yard Squiggle—Light Green
—	¼ yard Plaid—Pink Multi (binding)
—	¼ yard Tossed Flower—Yellow Multi 
—	¼ yard Squiggle—Orange
—	½ yard Plaid—Pink Multi (napkins)
—	½ yard Leaf Vine—Green Multi (napkins)

•	Assorted scraps for appliqué
•	Two 14" x 18" rectangles of batting
•	OESD Ultra Clean & Tear Stabilizer
•	505 Temporary Adhesive Spray
•	Isacord Embroidery Thread (colors 0015, 0025, 

0112, 4174, 9406)
•	OESD Bobbin Thread

•	Organ Embroidery needles, size 80/12
•	Construction thread
•	One spool King Tut by Superior Threads, color #926
•	YLI Variations thread in color 0916, Tulip
•	Marking pencil or Chaco Liner
•	Fray Block
•	Olfa Rotary Circle Cutter (or ruler compass)
•	Appliqué scissors
•	Sewing and embroidery system
•	Serger
•	Mega Hoop (or your largest hoop)
•	Medium hoop
•	Edgestitch foot (BERNINA Edgestitch Foot 

#10/10C/10D)
•	¼" foot (Patchwork Foot with Guide #57/57D)
•	BERNINA Stitch Regulator #42, or your favorite 

free-motion quilting foot
•	Binder Attachment (BERNINA Binder Attachment 

#84 with Foot #94 OR Binder Attachment #88 with 
Foot #95)	

The exclusive Floralicious 
Embroidery Collection will 
be available at your local 
authorized BERNINA Dealer 
in May 2011

http://www.berninausa.com/dealer_search2-n99-sUS.html
http://www.benartex.com/page/index.php?page=gallery-detail&pg_o=&collection=291
http://www.benartex.com/page/index.php?page=gallery-detail&pg_o=&collection=291
http://www.berninausa.com/content-n798-sUS.html
http://www.berninausa.com/content-n798-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_overview-n3-sUS.html
http://www.berninausa.com/product_overview-n5-sUS.html
http://www.berninausa.com/product_search-n29-r17-sUS.html
http://www.berninausa.com/product_detail-n25-i140-sUS.html
http://www.berninausa.com/product_detail-n25-i68-sUS.html
http://www.berninausa.com/product_detail-n26-i166-sUS.html
http://www.berninausa.com/product_detail-n25-i340-sUS.html
http://www.superiorthreads.com/shop/category/king-tut/colorcards/
http://www.ylicorp.com
http://www.organ-needles.com/english/product/index.html
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=4090
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBT17-15


Floralicious 
Placemats & 

Napkins

Place embroidered napkin sleeve wrong sides 
together one of the plain 6" x 7" pieces of Light 
Green Squiggle. Trim both layers to 4½" x 5". 

Repeat for the second napkin sleeve.

Embroider the Side Panel
Open “Floralicious” design 
#110310 in BERNINA Embroidery 
Software or the embroidery 
machine. 

Select Mirror Horizontal and 
then duplicate the design two 
times. Place the copies in a 
vertical column within the 
bounds of the Mega Hoop, 
spaced evenly. Save.

Hoop a piece of OESD Clean & Tear stabilizer in the 
Mega Hoop and spray it with 505 Temporary Adhesive 
Spray.

Place one of the 6" x 16" pieces of Light Green 
Squiggle on the sticky stabilizer. 

Stitch a basting box around the design.

Stitch the appliqué placement lines; then adhere the 
appliqué fabrics in place with 505 spray.

Stitch the tackdown stitches; then trim the fabric 
from outside the stitching. 

Return the hoop to the machine. Continue stitching 
to complete the appliqué and embroidery. 

Tear away the excess stabilizer when embroidery is 
complete and trim panel to 4" x 4½". 

Repeat for the second side panel.
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Cut the Fabric
Placemat Fronts—with Napkin Sleeve
Cut from Small All Over—Black Multi 
•	two 4½" x 14½" rectangles
•	two 13¾" x 14½" rectangles
Cut from Squiggle—Light Green 
•	two 6" x 16" rectangles
•	four 6" x 7" rectangles

Cut from Leaf Vine—Green Multi 
•	two 1½" x 14½" rectangles

Placemat Backs—with Patchwork
Cut from Small All Over—Black Multi 
•	two 9½" x 7½" rectangles

Cut six 4" x 5" rectangles from each fabric
•	Tossed Flower —Yellow Multi
•	Leaf Vine—Green Multi
•	Squiggle—Light Green
•	Squiggle—Orange

Embroider the Napkin Sleeve
Spray a piece of OESD Clean & Tear stabilizer with 
505 Temporary Adhesive Spray and adhere it to the 
back of one of the 6" x 7" pieces of Light Green 
Squiggle. Hoop them in the Medium Hoop.

Open “Floralicious” design #110310. Stitch the 
appliqué placement line.

Lightly spray the 
appliqué fabric with 
adhesive and place in 
position to cover the 
stitches. 

Stitch the tackdown 
stitches. Remove 
the hoop from the 
machine and trim the 
fabric from outside 
the tackdown stitching, 
taking care not to cut 
the stitches. 

Return the hoop to 
the machine. Continue 
stitching to complete 
the appliqué and 
embroidery. Tear away 
the excess stabilizer 
when embroidery is 
complete.



Construct the Placemat
Front—with Napkin Sleeve
Cut scant 1⅛" bias strips from the Plaid—Pink Multi 
fabric.

Install the binder 
attachment on the 
sewing machine. 
Bind the upper and 
lower edges of the 
napkin sleeve and 
the long sides of 
the embroidered 
panel following 
the instructions 
included with the 
binder.

Center the embroidered panel on one of the 13¾" x 
14½" Small All Over—Black Multi fabric rectangles.

Attach the edgestitch foot to the machine. Adjust 
the needle position to the left. Stitch along both 
sides of the embroidered panel to secure it to the 
placemat.

Attach the quarter 
inch foot to the 
machine. Stitch 
the 1½" strips 
of Leaf Vine—
Green Multi to 
the left side of 
the placemat 
using a ¼" seam 
allowance.

Center the napkin sleeve on the right side of the 
placemat, embroidery side down.

Place the 4½" x 14½" 
rectangle of Small All 
Over—Black Multi on top, 
sandwiching the napkin sleeve 
between the two placemat 
pieces. Stitch together using 
a ¼" seam allowance. Press 
seam allowances toward the 
sashing. 

Back—with Patchwork
Stitch the 4" x 5" rectangles 
together using a ¼" seam 
allowance, following the piecing diagram.
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Sandwich the batting 
between the front and 
back placemat pieces 
(wrong sides toward the 
batting).

Stitch around all four 
sides, leaving a 5" 
opening in the middle of 
one side for turning.

Turn right side out. Turn the edges of the opening 
under ¼". Press.

Attach the edgestitch 
foot to the sewing 
machine and adjust 
the needle position 
approximately ⅛" to 
the left. Stitch around 
all four sides of the 
placemat.

Install the BERNINA 
Stitch Regulator 
#42 to the machine. 
Stipple quilt around 
the flowers on the 
embroidered panel.

Construct the Napkin
Lightly spray the wrong side of each fabric—Leaf 
Vine Green Multi and Plaid Pink Multi—with 505 
temporary fabric adhesive spray.

Place the two fabrics wrong sides together. 

Use the Rotary Circle Cutter to cut two 18" circles  
(= 9" radius) from the layered fabrics. 

Place the threads on the serger in this order:

•	Isacord on the second spool pin
•	Variations one spool to the right
•	King Tut on the far right spool pin

Thread the King Tut and Variations threads through 
the lower looper together; this will create a blended 
effect on the napkin edge.



Thread the needle with Isacord. Set the serger for a 
2-thread rolled edge with the following settings:

•	Upper Looper = Adapter attached
•	Lower Looper = 4
•	Right Needle = 4
•	Left Needle = removed
•	Upper Knife = engaged
•	Stitch Length = 1.0
•	Differential Feed = N to 1.5
•	Cutting Width = 1.0
•	Roll Hem Selection Lever = engaged

Test the stitch on a 
double layer of fabric. 
Adjust the settings in 
small increments. 

Serge around the first 
double-layer circle, 
trimming the edge 
slightly. Adjust the 
differential feed as 
needed if the edge 
becomes wavy.

When nearly at the 
beginning of the stitching again, overlap the stitches 
about ½" rather than tapering off the edge. Raise 
the presser foot and gently release the threads. 
Carefully pull to the side to create a thread tail. 

Seal the overlapped stitched with Fray Block. Clip 
the thread tails when dry.
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http://www.berninaUSA.com
http://www.rickytims.com/seminars
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Supplies
•	BERNINA 830
•	Jumbo Hoop
•	OESD Floral Visions Embroidery Collection #001
•	BERNINA DesignerPlus Embroidery Software 6
•	OESD LightWeight Tear-Away Stabilizer
•	OESD Fuse & Fleece or Pellon Fusible Batting
•	Fabrics from the Flutter Collection by Benartex
•	3 fat quarters Linen Texture Lichen Green for top & back
•	5" x 7" piece Linen Texture Mossy Green for appliqué
•	¼ yard of Garden Vine Olive Green for the ruffle
•	Isacord Embroidery Thread
•	Bottom Line in a neutral color for the bobbin
•	Hilos Le Espiga nylon cord in a coordinating color
•	Monofilament thread
•	Organ Titanium Embroidery needle, size 80/12
•	Double-curve embroidery scissors
•	14" x 14" square pillow form
•	Ruffler #86
•	Freemotion Couching Foot #43

by SUSAN FEARS

Floral 
Visions 
Pillow
The BERNINA 830 has the tremendous 
capability of bringing ALL sewing and 
decorative stitches into its embroidery 
system, and embroidering them instead of 
stitching them. Once a stitch is turned into 
an embroidery design in the embroidery 
system, it can also be saved as a design to 
a BERNINA Memory Stick and then used 
in the DesignerPlus BERNINA Embroidery 
Software 6. The BERNINA 830’s Endless 
Embroidery feature does an excellent job of 
using stitches in a linear fashion, but curved 
shapes are not as easily created. Expand 
your embroidery capabilities by combining 
two state-of-the-art BERNINA products 
– the BERNINA 830 and BERNINA 
DesignerPlus Embroidery Software 6 – as 
you create this lovely heirloom pillow.

http://www.bernina8series.com/EN/
http://www.bernina8series.com/EN/
http://www.bernina8series.com/EN/
http://www.bernina8series.com/EN/
http://www.berninausablog.com/susan-fears
http://www.berninausa.com/product_search-n29-r17-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.berninausa.com/product_detail-n25-i149-sUS.html
http://www.berninausa.com/product_detail-n25-i59-sUS.html
http://www.organ-needles.com/english/product/index.html
http://www.superiorthreads.com/shop/category/bottom-line/description/
http://www.berninausa.com/product_detail-n6-i293-sUS.html
http://www.benartex.com/page/index.php?page=gallery-detail&pg_o=&collection=146
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=400-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBT15-15
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBFF-10
http://www.embroideryonline.com/products/Licensed.aspx?Media=DL&CatID=166&SubCatID=545


•	A dialog box appears indicating that the pattern 
has been created successfully.

•	Repeat the Create Pattern process to transfer all 
of the captured BERNINA 830 stitches into the 
Pattern Run Library of the software.

Note: The patterns are saved in the Pattern Run 
Library under the named file set, such as 830 
Stitches. To use these stitches, select Outline > 
Pattern Run. Creating new Pattern Run stitches 
creates unique opportunities for creating lines 
and shapes beyond the built-in features of the 
DesignerPlus software.

Embroider the Pillow Top

Create the Floral Frame
•	From the OESD Floral Visions Collection, open 
design #BC00140, the little leaves border.

•	Select the design, and then left click on the Rotate 
C/CW icon two times.

•	Right click on the Hoop icon and select Jumbo 
Hoop #26.

•	Select File > Insert and select design #BC00128, 
little flowers border 2.

•	Click on the Mirror Image Vertical and Mirror Image 
Horizontal icons, and then arrange the designs to 
form a corner.

•	Resequence the stitching order by holding down 
the CTRL key, touching the flower border and 
then touching the leaves border. Select Arrange > 
Sequence as Selected. Alternatively, drag and drop 
the objects in Color File.

•	Select All, then Group the corner design.

Tip: Select the Zoom tool for easier viewing.

•	With the corner design highlighted, select Edit > 
Duplicate.

•	Select Mirror Image Horizontal and drag the new 
corner to form the upper right corner of the floral 
frame. Select All and Group.
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Convert BERNINA 830 Stitches into 
DesignerPlus Pattern Run Stitches

Turn a Sewing Machine Stitch into  
an Embroidery Object
•	Select decorative stitch #1118.

•	Touch the embroidery module icon.

•	Open the My Designs folder and select the stitch.

•	When the stitch appears on the screen, select the 
Save icon. Press the flashing file to save the stitch 
design to the USB stick.

•	Repeat for stitches #819, #523, and #1211.

Note: Sewing stitches can only 
be brought into embroidery one 
at a time. Create several at one 
time to make the transformation 
process more efficient.

Take the Stitch Design into the  
BERNINA Embroidery Software
•	Open the DesignerPlus 6 software and insert the 
USB stick into the appropriate computer port.

•	Select File > Open and select one of the stitch files 
from the USB stick. These were saved as EXP files, 
so be sure to select Files of Type > EXP to enable 
the stitches to be listed.

•	Open the stitch file.

Create a Pattern with the 830 Stitches
•	With the stitch pattern on the screen, use the 
Select Object tool to select it.

•	Select Settings > 
Create Pattern. 
In the dialog box, 
create a folder 
called 830 Stitches.

•	Select New Set and 
type the name, then 
click OK.

•	The prompt area in the lower left corner of the 
screen indicates that a start points needs to be 
identified; click on one end of the pattern to 
create one.

Note: Drawing upper/lower or left/right for the 
beginning/ending points will cause the pattern to be 
drawn a different way when used.
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•	Select Edit > Duplicate. Select Mirror Image 
Vertical and drag the copy to form the lower half 
of the frame.

•	Select All, and then click on the Align Left Vertical 
icon.

•	Select All, then Group 
the design.

•	Check to make sure 
that all of the design 
elements fit inside 
the embroidery field 
of the Jumbo Hoop. 
Rescale if necessary. 
(The sample was 
reduced to 95%.)

•	Save the design as 
Floral Frame.

Create the Ring Pattern

•	Click on the Grid icon to activate the grid. 

•	Select the Circle/Oval tool and Outline > Satin. 
Draw an oval in the center of the hoop, about 4½ 
squares tall and 4 squares across. Press Enter to 
set the Oval.

•	Press ESC to exit the 
tool.

•	With the oval 
selected, select the 
Outline Design icon.

•	In the dialog box, 
select Offset = 10mm, 
Line Count = 5, 
Outline Type = Single 
Stitch, and deselect Outline Holes. Press OK.

Note: Each ring can be selected individually and a 
pattern run stitch substituted for the single stitch 
outline.

• Save as Pillow 1.

Use BERNINA 830 
Stitches as Pattern Runs
•	Select the outline 
closest to the satin 
oval. Click on the 
Object Properties icon 
and select the Outline 
Stitch tab. 

•	Set the Stitch Type to 
Pattern Run.

•	Click on the Select button. In the Patterns drop 
down menu, select 830 Stitches > ST819. Click OK.

•	Set the Spacing at 42mm. Click Apply to audition 
the effect and keep the dialog box open, or click 
OK to set the stitch and close the dialog box. Move 
the dialog box for a better view of the stitches.

•	Select the second outline; select the 
Candlewicking outline.

•	Select the third outline; 
select Pattern Run 
#ST1118.

•	Select the fourth 
outline; select Pattern 
Run #ST523.

•	Select the fifth outline; 
select Pattern Run 
#ST1211.

•	Resize the outlines 
so that the last one 
intersects the floral frame.

•	To re-center the outline, Select All and click on the 
Align Centers icon.

Create the Center Appliqué
•	Select the oval. 

•	Select the 
Advanced 
Appliqué tool. 
Select Fabric > 
Benartex 2006 > 
Kaye’s Cottage > 
#1325-44. Select 
Back.

•	Select Set Stitch 
Types Manually 
and select the 
oval. Check the 
box for all options 
and set the Tack-Down Stitch to Zigzag.

•	Press Back and Close.

Insert the Center Design
•	Select File > Insert Design > Floral Visions 
Embroidery Collection > #BC00130.

•	Position the design in the center of the oval.

•	Rearrange the stitching order by rearranging the 
color chips in Color Film. 

—	Set the Pattern Outlines to stitch first
—	Set the Appliqué shape to stitch second
—	Set the Floral Frame to stitch third
—	Set the Flower in the oval to stitch last
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•	Select Save As and save a copy of the design.

•	Note: It’s always a good idea to save a copy of a 
design so you’ll have a copy if you want to make 
any changes later.

•	Click on the Write to Machine icon to correctly 
transfer the design to the USB stick or directly to 
the BERNINA 830 via cable.

Embroider the Pillow Top
•	If the Jumbo Hoop has not been calibrated since 
the last update, or it is a new hoop, calibrate it in 
Setup. 

•	Select the design from the USB stick.

•	Prepare a fat quarter by fusing OESD Fuse & Fleece 
or Fusible Pellon to the wrong side. Hoop it with 
two layers of OESD Ultra Clean & Tear.

Construct the Pillow
•	Trim the pillow front to 15" x 15" square.

•	Make the ruffle:

—	Cut 2½" strips of the dark green fabric, piecing 
them together to make 2-3 yards.

—	Fold strip in half lengthwise and press.

—	Attach Ruffler #86 to the sewing machine and set 
the ruffler guide to 6.

—	Select a straight stitch and adjust the stitch 
length = 2 mm.

—	Guide the folded strip into the ruffler, raw edges 
to the right and the folded edge to the left of the 
needle, allowing the fabric to feed evenly. 

•	Cut two 12" x 15" rectangles for the pillow back. 
Stitch a 1” double hem along one long side of each 
rectangle. With right sides facing up and the hems 
toward the center, overlap the two rectangles to 
form a 15" x 15" square. Baste them together.

•	Stitch the design following the screen prompts.

•	Use Freemotion Couching Foot #43, monofilament, 
and a straight stitch to couch purchased cord 
around the embroidered area of the pillow front, 
filling the 16" square area.

•	Round the corners of the 
pillow front.

•	With raw edges even, 
stitch the ruffle to the 
right side of the pillow 
front, overlapping the 
ends and bending them 
perpendicular to the 
pillow edge to hide the 
raw ends.

•	Sew the pillow front and 
back right sides together. 
Trim excess fabric at 
corners.

•	Turn right side out and 
insert the pillow form.



2 0  •  T H R O U G H  T H E  N E E D L E  O N L I N E

The Last Word

Quick Links
These are the main links featured in 
this issue; see the articles for links to 
specific products, projects, and technique 
information. Please visit our sponsors 
and contributors for more inspiration, 
information, and stitching fun!

•	http:/ /www.  throughtheneedle.com 
•	http:/ /www.  berninaUSA.com 
•	http:/ /www.  benartex.com
•	http:/ /www.  berninausablog.com
•	http:/ /www.  embroideryonline.com 
•	http:/ /www.  bernina8series.com/EN/ 
•	http:/ /www.  berninamylabel.com 
•	http:/ /www.  rickytims.com/seminars

A sneak peek at what’s coming in  
Through the Needle ONLINE, Issue #6:

Striped Windows
Designed by Liza Lucy, co-author of several quilting books with Kaffe 
Fassett, the beautiful coloration and rich texture of this striking wall-
hanging are created with Fassett’s yarn-dyed woven stripes. Don’t 
be fooled by its complex appearance—the quilt’s foundation-pieced 
blocks are easy to construct. 

Dimensional Flower Embroidery
This exquisite 3D flower, digitized by Jeanine 
McWhorter, is simple to assemble and makes 
a stunning accessory. They’re so beautiful, 
you’ll want to experiment with different 
color combinations and create a bouquet of 
blossoms that’s uniquely your own. 

May 2011 Special
Expand your Foot Knowledge!
Learn about settings and 
techniques for over a hundred 
BERNINA presser feet and 
accessories using these 
comprehensive reference books. 
For May 2011 only, get 20% OFF 
all Feet-ures Books. Coupon may 
be used for one or more volumes.
Offer good May 2011 at participating BERNINA 
dealers in the USA and Canada. Only one May 
2011 Coupon may be used per person.

20% OFF

Feet-ures Books 
(Volumes 1, 2, and 3)

Until June ... 
As always, we hope this issue of Through 
the Needle ONLINE has inspired you to learn 
something new and make your own adaptations 
of our projects. We love seeing your creations; 
send e-mail and photos to jo @ berninausa.com.

Make Perfect Pintucks!
Stitch wide decorative designs 
between perfectly placed rows of 
pintucks easily and quickly!
For April 2011 only, purchase a 
BERNINA #46 Clear Pintuck Foot 
and receive a 2.0 Double Needle 
FREE.
Offer good April 2011 at participating BERNINA 
dealers in the USA and Canada.

April 2011 Special
FREE  

2.0 Double 
Needle

with purchase of #46 
Clear Pintuck Foot
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